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The significant new feature in Do-more 2.0 is the 

introduction of the new BRX line of Micro PLCs.  

However, there are many cool features in 2.0 

that enhance the entire product line.  The first 

part of this document will highlight the new BRX 

platform and features; the last part of this 

document will highlight the common features 

across all Do-more platforms (205, Terminator, 

Simulator, and BRX). 

Before diving into the new BRX line of PLCs, there are some key user interface enhancements which 
will help you with your work flow. 

 
Dashboard View 

The new Dashboard view is a one-stop-shop for getting status of your PLC, configuring the “screw-
head” centric pieces of your project along with configuring many other areas, and as a general software 
navigation tool.  All the existing Menus, Toolbars, and Hot Keys are also still around and still work, so 
continue to use those if you like (however, even some “experts” have admitted to liking this new user 
interface!)  It’s even more powerful if you have multi-monitors or a wide monitor and “tear it off” and 

access it outside the Designer window frame (see Float/Dock button  on view’s left-toolbar). 

Float your mouse cursor over the picture of your PLC model and suddenly all the hot-spots are 

highlighted.  Float over a hot spot to get general information about that specific area of the hardware.  

Right click on a hot spot to get a context specific menu.  Left click on a hot spot and get a Pop-up Tip 

that will contain information and hot links to other areas of Designer related to that hot spot. 
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Each of the Panels that surround your PLC graphic relates to a specific area of your current project 

(Program, Documentation, Communications, I/O, CPU, Memory, Devices).  Within each panel are 

project status information items, most of which are also hot links.  Again, float your cursor over each 

one to get more detailed status information about that item.  Click on the hot linked items and it will 

either show a Pop-Up Tip with more navigation options, or will take you directly to the 

configuration/status dialog related to that item. 

Built-in Video Training has been integrated into Do-more Designer, whether it’s learning how to 

configure an analog module, or learning the basics of Designer 2.0, video help is just 1 or 2 mouse 

clicks away. 

 
New Start Page Videos  

The Start Page has been changed to provide hot link buttons to play 5 new videos that will help you get 
up and running with Designer 2.0. 

1. Welcome to Designer 2.0 
2. How to Create a Simple Program 
3. Troubleshooting Tips 
4. Do-more PLC Architecture 
5. Helpful Hints 

 
The 6th button lets you navigate, play and optionally download any/all the hundreds of short videos 
(details below). 

If you ever see the red Play button  in 
the top toolbar of an instruction editor 
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or in the top left corner of a dialog box 

 

just click on it to play a short training video 
dealing with that specific instruction 

 

or the dialog box topic 

 

If you see the red Play button in the 

title of a Panel in the new 

Dashboard view… 

 

…click on it to see a list of videos 

related to that panel 
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New BRX Micro line of PLCs 

 
General BRX Micro PLC Features 

All of the various BRX Micro PLC Units (MPUs) are stackable, with built-in Power Supply/CPU, 

varying in size from no onboard I/O, up thru 36 points of onboard I/O.  Most MPUs support up to 8 

stackable modules, able to handle over 160 I/O locally (Ethernet units can support thousands of 

I/O via Ethernet I/O).  Many MPUs have at least two analog I/O channels onboard. 

The mix of Power-Supply/Input Types/Output Types/Ethernet in the BRX line result in 38 different MPU 

models (sub-types).  The new File->New->Offline Project dialog highlights the key differences between 

MPU sub-types, helping to make the selection easier.  After selecting the BRX Hardware Class, then 

Ethernet vs. non-Ethernet Type, you get a list of all the possible MPU sub-types, with key specification 

features listed below a picture of the selected sub-type MPU model: 
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BRX MPU Model Differentiation 

The first differentiator in the BRX hardware class is onboard Ethernet vs. not (similar to the H2-DM1 

and T1H-DM1 CPUs).  All Ethernet models (BX-DM1E-x) are fully expandable up to 8 expansion 

modules, and most of them have at least 1 or 2 analog output channels and 1 to 4 analog input 

channels.  The non-Ethernet models (BX-DM1-x) are value-priced, without the extra cost of the analog 

channels onboard and support for only 2 or 4 expansion modules. 

The second differentiator is the number of onboard Discrete I/O. 

 
None, 10, 18, and 36 

The remaining differentiators are Power-Supply type (A/C vs. D/C) and Onboard Discrete Input and 

Output types (A/C, D/C, Voltage Level, Relay, Sinking vs. Sourcing). 

BRX Micro-SD Slot 

Every BRX MPU model has a micro-SD card slot for storing or accessing data files in standard disk 

format readable by PCs.  New FILE**** instructions allow you to simply log data, or perform complete 

read/write file access.  BRX also supports a second file system that is a RAM-drive (note: all existing 

H2 and T1H Do-more PLCs can also support a RAM-drive file system after a simple firmware upgrade 

to Do-more Technology Version 2.0 or later).  The EMAIL instruction has been enhanced to allow you 

to add a file attachment from the BRX micro-SD card or a file from your existing H2-DM1E, 

T1H-DM1E, or new BRX RAM-drive file system. 

BRX Pluggable Option Module (POM) Slot 

Every BRX MPU model contains a Pluggable Option Module (POM) slot.  This slot is hot-swappable 

with various POM modules, allowing you to have dynamic functionality when needed (like during 

commissioning or maintenance), or as a permanent option: 

 
Ethernet 

 
USB 

 
RS-232 RJ-12 

 
RS-232 3 Pin 

 
RS-485 



 Do-more Updates Rel 2.0, February, 2017 

 Page 6 of 30 

BRX Expansion Modules 

Initially, the BRX line of PLCs supports 27 different I/O modules (more modules planned): 

 10 different Discrete Input modules 

 12 different Discrete Output modules 

 5 different Discrete Input/Output Combination modules 

Coming soon: 

 8 different Analog Input modules 

 4 different Analog Output modules 

Other expansion modules are in-work and are planned to be released soon. 

BRX Onboard High Speed I/O 

Most of the BRX models support some combination of High Speed Inputs and/or High Speed Outputs 

onboard (no extra cost).  Both Input and Output frequencies support up to 250K Hz. 

Specific Onboard High Speed Input features include 

 High Speed Counting (Up, Down, Quad, Bi-directional, Up-Down) 

 High Speed Timing (Single Edge, Dual Edge) 

 Interrupts (Discrete Input Event of Rising/Falling/Either with optional Hi/Lo Level “permissives” 

of any/all other onboard inputs) 

Specific Onboard High Speed Output features include 

 Axis Motion (Step/Direction, Clock-wise/Counter-clock-wise, Quadrature emulation) using 

various AX* instructions (AXJOG, AXHOME, AXPOSTRAP, AXPOSSCRV, AXVEL, AXGEAR, 

AXFOLLOW, AXCAM, et.al.); up to 4 Axis (1 virtual Axis, up to 3 tied to actual outputs) 

 Pulse Width Modulation configured via the PWM structure members .Period and .DutyCycle 

 Table Driven Output using TDO* instructions (Programmable Limit Switch; Preset Table script 

of various Set, Reset, Toggle, Pulse On, Pulse Off after micro-second duration) 

BRX Onboard Analog Configuration 

The BRX MPU units that come with onboard Analog Inputs and Analog Outputs let you fully and 

independently configure each analog channel’s electrical characteristics, so there is no need to 

qualify these when purchasing, or buy multiple module types for different signal types! 

 current vs. voltage 

 unipolar vs. bipolar 

 voltage range 

 resolution (14, 15, 16 bits) 

 optionally scale WX analog input to new RX (Real Analog Input) data-block  

or from new RY (Real Analog Output) data-block to WY analog output, 

with or without clamping 
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BRX Interrupt Support 

There are three different types of Interrupt Triggers: Discrete Input Events, Time, Match Register: 

   

4 Input Event Triggers 4 Timed Triggers 4 Match Register Triggers 

Interrupt Service Routines (ISRs) are a new kind of code-block that get associated to a specific 

Trigger.  Up to 20 ISR code-blocks are supported. 

Immediate Output Instructions include OUTI, SETI, and RSTI, which are powerful within ISR code-

blocks.  There is no need for an Immediate Input Contact because every ISR execution gets a copy of 

the immediate onboard Discrete Input X state values upon being fired.  So just use the “immediate” X’s 

like you would any other X inside an ISR code-block. 
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INTCONFIG – Configure Interrupt Instruction 

The configuration of any Interrupt Trigger can be changed dynamically at runtime using the 
INTCONFIG - Configure Interrupt instruction, including remapping the associated ISR code-block.  The 
INTCONFIG instruction can be used within an ISR code-block for some pretty powerful program 
control.  For example: 

 Dynamically control a high resolution discrete output using calculated timing values to reconfigure 
the Timed Event Trigger within the current ISR. 

 Follow-up a Discrete Input Event with a calculated Timed Event Trigger within the Input Event 
ISR. 

 Tweak the Match Register condition to the “next” Match Register condition within the ISR. 

 Any combination of Trigger settings and/or ISR code-block binding 

Other Interrupt instructions include INTSUSPEND – Suspend Interrupts, INTRESUME – 

Resume Interrupts, and INTDECONFIG – Deconfigure Interrupt Trigger Resource. 

High Speed I/O 

CTRIO functionality for BRX platform has been replaced with the following onboard resources that 

come with nearly every BRX MPU model: 

 Counter/Timer Functions 

 Axis/Pulse Outputs 

 Pulse Width Modulation 

 Table Driven Output 
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New Motion Control: Axis 

Every BRX MPU model supports up to 3 Axis Pulse Output resources (a fourth Axis is permanently 

“Virtual”, meaning it cannot be tied to any physical pulse outputs, but can still be used to generate 

logical pulse counts using any of the AXIS* instructions, just like the other “hard-wired” axis). 

Each Axis can be configure as: 

 Virtual (does not drive any 
physical I/O) 

 Pulse Output Step and Direction 

 Pulse Output 
Clockwise/Counter Clockwise 
Selection 

 Pulse Output Quadrature 
(emulates a 4x quadrature 
sequence) 

Except for Virtual, the other modes 
physically bind to two different onboard 
Discrete Y outputs.  

 

 

At runtime, the detailed configuration of 
an AXIS must be configured using the 
AXCONFIG – Configure Axis instruction. 
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AXJOG – Axis Jog Mode 

It is a 3-input leg instruction to perform a 
simple “jog”.  The input legs are 

1. Enable/Reset 
2. Forward 
3. Reverse 

  

AXHOME – Axis Perform Home Search 

 

 

AXPOSTRAP – Axis Move to Position 

Using Trapezoid 

 

 



 Do-more Updates Rel 2.0, February, 2017 

 Page 11 of 30 

AXPOSSCRV – Axis Move to Position 

Using S-Curve 

 

 

AXVEL – Axis Set Velocity Mode 

 

 

AXGEAR – Axis Electronic Gearing 
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AXFOLLOW – Axis Position Following 

with Offset 

 

 

AXCAM – Axis Electronic Camming 

The AXCAM instruction also has an 

online tool for easily editing/graphing 

PLC Memory based Curve Fitting Points.  

Access it via the PLC->Axis Cam Table 

menu. 

 

 

AXSETPROP – Set Axis Properties 

 

 

AXRSTFAULT – Reset Axis Limit Fault 
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Pulse Width Modulation 

Each BRX MPU supports up to 3 onboard Hardware 
Accelerated High Speed Output PWMs to precise microsecond 
or millisecond resolution.  Once the PWM Output is configured, 
use the PWM’s heap item’s structure fields to control the PWM 
from your logic: 

 .Enable 

 .PeriodScale (bit 0: microsecond, 1: millisecond) 

 .Period (time value 0 to 2,147,483,647) 

 .DutyCycle (real percentage 0.0 to 100.0) 
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Table Driven Output (TDO) 

BRX supports up to 4 onboard Hardware Accelerated Table 
Driven High Speed Outputs in response to high speed Counters, 
Timers, and Pulse Outputs. 

 

 

Use the TDOPRESET – Load Preset Table for Table Driven Output or the TDOPLS – Load 

Programmable Limit Switch Table for Table Driven Output instructions to drive the high speed discrete 

outputs. 

TDOPRESET – Table Driven Output 
Preset Table 

The TDOPRESET instruction also has an 

online tool for easily editing PLC Memory 

based TDO Preset Table.  Access it via 

PLC->TDO Preset Table menu. 
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TDOPLS – Load Programmable Limit 
Switch Table for Table Driven Output 

The TDOPLS instruction also has an 

online tool for easily editing and graphing 

PLC Memory based TDO PLS Table. 

Access it via PLC->TDO PLS Table 

menu. 

 

 

TDODECFG – Deconfigure Table Driven 

Output 

 

 

Configurable Discrete Input Filters  

The onboard Discrete Inputs response 

times are configurable on every BRX 

MPU.  Many of the MPU models’ Discrete 

Inputs support very high frequency at the 

hardware level (up to 250K Hz).  These 

response times can be configured through 

the System Configuration’s Setup 

Discrete Input Response Times dialog. 

You can enter the filter in any of 3 

different scales:  

 Frequency 

 Time in nanoseconds 

 Raw Clocks 
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New Features in Designer 2.0 for All PLC Lines, including Do-more Technology Version 2.0 

The new Select Project dialog is the 
Launch Pad on steroids.  It lists all your 
recent projects sorted by the Last Opened 
date by default, so your most recent 
projects are near the top. 

You can sort by any of the columns, not 
just Last Opened: 

 Project name 

 Folder 

 Last Opened date/time stamp 

 Link name 

 Link Information 

 Link Description 

 PLC type 
 

 

You can also create a New Offline Project, a New Online Project, or Browse to open up an unlisted 

project file. 

The dialog box is resizeable, so if you have the screen real estate, feel free to enlarge the dialog and 

widen those columns.  It remembers its location and sizes so that once you set it up, it will remember 

from launch to launch.  It automatically shows up at start-up, but you can disable that functionality by 

UNchecking the checkbox in the lower left corner. 

RAM Drive File System (DmT 2.0) 

Do-more Technology Version 2.0 added a RAM Drive File System, so existing H2-DM1x, T1H-DM1x 

CPUs can support the new FILE* instructions with a simple firmware upgrade (BRX supports it out of 

the shoot; includes FILELOG, FILEOPEN, FILEREAD, FILEWRITE, FILECLOSE, FILEDEL, 

FILECOPY, FILENEWFLDR,  FILEQUERY, FILESYSCMD, FILESEEK, FILETRUNC). 
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The most useful FILE instruction is the 
new FILELOG – Log to File instruction.  It 
makes data logging very simple, but very 
configurable. 

The most common requirement is that you 
need a specific set of data points to be 
logged at a specific interval (once a day, 
once an hour, once a minute, etc.).  Each 
FILELOG instruction lets you specify the 
desired interval and set of data points. 

You can mangle the name of the .csv file 
starting with a “Base” .csv (Comma 
Separated Variable text file) name, 
appending the Date/Time stamp to the 
nearest hour, day, month, or year (e.g. 
“MyFILELOG” to the nearest day: 
MyFILELOG_y2016m12d07.csv).  This is 
optional. 

 

 

After uploading the file using the Browse PLC File System dialog to your PC, the resulting file contains 
a header line showing the PLC variable names, but always starts with the current Date/Time stamp.  
Then it will have all the log entries for each day/hour/minute/whatever.  The example to the right may 
look like: 

"TimeStamp(sec,local)","V100","V101","R100","CT0.Acc" 

2016/12/7 18:09:00,42,256,3.14,199 

2016/12/7 18:10:00,43,301,3.14,211 

2016/12/7 18:11:00,57,301,2.82,0 

 

The .CSV text file can be easily opened by Excel or Notepad or imported by most database programs. 

You can also just log data on an event, not a periodic time interval.  Just change the Input Leg setting 

to Edge Triggered from Power Flow.  Also, the Base .csv File Name can be a generating STRING 

element (e.g. SS42) in case you want to come up with your own naming convention.  Just use 

STRPRINT to write to SS42. 

Finally, if you want to attach these .CSV log files to an EMAIL, the Generate File Name checkbox will 

come in handy to plug the Attachment file name in the EMAIL instruction (e.g. SS5 for the Generate 

File Name parameter would contain MyFILELOG_y2016m12d07.csv from the first example above, 

then use SS5 in your EMAIL instruction’s “Attach File Name” parameter. 

If you want to do your own FILE I/O calls, the breadth and depth is typical.  Note that not every file 

system command is supported – this is a PLC not a PC, and some of those commands could take a 

LONG time, like removing a folder.  Hence, Remove Folder is not supported by Do-more.  But if it’s 



 Do-more Updates Rel 2.0, February, 2017 

 Page 18 of 30 

removable media, you can remove it from your PLC and put it on a PC and still do everything you want 

to do from your PC (remove folders, format the media, run diagnostics, etc.). 

FILEOPEN – Open File 

 

 

FILEREAD – Read from File 

 

 

FILEWRITE – Write to File 
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FILECLOSE – Close File 

 

 

FILEDEL – Delete File 

 

 

FILECOPY – Copy File 

 

 

FILENEWFLDR – Make New Folder 
(note that there is no Remove Folder 
instruction) 

 

 

FILEQUERY – Query File or Folder 
Information 

This instruction lets you get detailed 

information on any File or Folder.  You can 

also use it to perform a “directory” 

operation to iterate all the files in a folder.  

The FILEQUERY Help Topic DMD0388 

shows an example on how to iterate a 

folder. 
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FILESEEK – Seek to Position in File 

You can seek to specific positions 

(Beginning, Current, or End) or an offset 

from those positions. 

 

 

FILETRUNC – Truncate File 

 

 

FILESYSCMD – Perform File System 
Command 

 Format (RAM Drive Only) 

 Dismount 

 Mount 
  

It is very useful to programmatically Dismount the SD Card before an operator tries to remove the 

media.  The PLC’s MEM LED will be RED when it is fully dismounted and safe to remove the media. 



 Do-more Updates Rel 2.0, February, 2017 

 Page 21 of 30 

Browse PLC File Systems Dialog (DmT 2.0) 

This dialog lets you explore the SD 
Card and RAM Drive file systems in 
your Do-more PLC.  You can copy files 
between your PC and PLC in both 
directions. 

(see  PLC->Browse PLC File Systems) 

 

 

New Designer Security Credential: Access to File System (FS) 

The Browse PLC File Systems dialog cannot be 

used by a Designer user whose credentials does 

not include File System (FS). 

If any of your existing projects utilize Designer’s 

Session Password facility that includes more than 

just the one Default User, you will have to 

manually add this privilege to any existing users 

that you wish to grant access to the File System. 

 

 

Subroutine Code-Blocks (DmT 2.0) 

All Do-more PLCs can support callable Subroutine code-blocks once their firmware has been updated 

to at least Do-more Technology Version 2.0.  The CALL instruction supports passing input parameters 

and returning output parameters “by value” through the global image register memory.  There is no 

actual “stack” for the parameter passing, just the CALL client side values are copied into the 

Subroutine’s Input parameters before calling the subroutine.  Then after returning from the called 

subroutine, the Subroutine’s Output parameters are copied into the client side CALL elements.  The 

stack DOES handle pushing the current CALL instruction address on the stack, and the Subroutine’s 
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Return/Conditional Return instructions does the clean-up, so nesting CALLs IS supported (up to 82 

levels of nested CALLs), but the parameters are NOT placed on the stack. 

For example, you can create an 

ADD subroutine that takes 2 input 

parameters and 1 output 

parameter.  The Subroutine 

reserves and uses the D100 and 

D101 registers for the two 

Addends, and D102 for the Add 

Result.  You can then CALL the 

ADD subroutine with 1, 2 and D0 

to get the result of 3 in D0. 

 
 

Now say you want to add 4 and 5 

together and store that in D1, you 

probably want to re-use your nifty 

new “ADD box” that you just 

created,.  Normally, you would 

need to remember that ADD uses 

D100 and D101 for the two input 

parameters, and D102 for the one 

output parameter. 

So after you pick a new CALL 

instruction, Designer knows that 

Subroutines are meant to be re-

used, so it asks you if you want to 

re-use an existing CALL signature 

for the Subroutine-side parameters 

for this new CALL box, and let you 

fill out the CALL-side parameters: 
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After hitting OK, you are given a 

more-than-half-filled-out CALL 

instruction. 

The Subroutine name, the 

Subroutine’s side Input and Output 

parameters are all filled out. 

All that’s left to do is fill out the 

three “red dot” empty parameters 

that are the “caller side” 

parameters (in this case, they will 

be 4, 5, and D1) 

 

 

It’s also good design to assign 

Nicknames to the global 

Subroutine input/output 

parameters, then your CALL 

instruction signature and 

Subroutine logic looks even better 

(e.g. ADD_Addend1, 

ADD_Addend2, ADD_Result for 

D100, D101, and D102, 

respectively): 
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Enhanced New Offline Project Dialog 

 

There is now a third selection level, PLC Sub-Type, which became necessary when the BRX was 
added due to the model/feature breadth of that new line.  By adding PLC Sub-Type, this also allows for 
205 Base Type selection, including an option of “unspecified”. 

The dialog also reports on general features of the specific sub-type selected, highlighting key features 
in green (like built-in Ethernet, or onboard analog I/O or …; see other example in the BRX section 
above). 

New Instructions and Instruction Enhancements 

With the addition of a RAM Drive 
File System to all existing Do-more 
PLCs with just a simple firmware 
upgrade, the existing EMAIL 
instruction was enhanced to add 
some optional parameters for 
sending attachments. 

A new STRPRINT/EMAIL Print 
Script command was created called 
TimeStamp() that optionally takes 
two parameters. 

Resolution: min or sec (default) or 
tenths or hundredths or 
thousandths. 

Clock-Time-Type: local (default) or 
utc 

 
 

The format of the date portion is always YYYY/MM/DD.  The format of the time portion is 24-hour, down 
to the specified resolution.  So the default is local time to seconds resolution, for example: 

2016/12/31 23:59:59 

If you need more detailed formatting capabilities, use the existing FmtDate() and FmtTime() script 

commands. 
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There is another STRPRINT/EMAIL Print Script command called Fill() that repeats the same character 

multiple times.  It takes 2 parameters: 

Fill-character/byte as hexadecimal constant 0x00..0xFF 

Fill-length (integer element or constant) 

So, Fill(0x20, 80) would generate 80 spaces (0x20 is the ASCII hexadecimal constant for a 

space). 

ENDC – Conditional End of Code-Block 
 

ENDC can be utilized in any PROGRAM, TASK or ISR code-block type.  Although END coils are not 

required by Do-more PLCs, the Conditional End within an Interrupt Service Routine is commonly 

needed to help keep the ISR running as fast as possible. 

Also, it is sometimes helpful to use END/ENDC for debug purposes to block out code execution in a 

PROGRAM or a TASK.  The ENDC box lets you do perform the End conditionally based on the input 

contact power flow state of the rung. 

Note that ENDC is different than the EXIT instruction in that ENDC can only end the current logic scan 

of that code-block, it does NOT end the execution of that code-block for subsequent scans, like EXIT 

does. 

Instruction Toolbox 

You can now hide any set of instruction 

classifications that you don’t ever use, freeing 

up more screen space in the Toolbox for the 

instructions that you do use. 

Just right click on the Instruction Toolbox and 

select Hide/Show Classifications, then UNcheck 

the classes you don’t ever use in the Show 

Classifications dialog box. 

 
 

 

 

Moved CTRIO set of instructions to its own Instruction Class. 

Added a higher level Download Firmware dialog accessed via the PLC menu, PLC toolbar, and 

Dashboard view.  You can still download firmware from the System Information dialog. 
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New System Words (DSTs) 

DST50 

DST53 

DST54 

DST55 

DST56 

DST57 

$InstalledPOM 

$PLCSubType 

$POMIpSetupSrc 

$POMIpAddress 

$POMIpNetmask 

$POMIpGateway 

see Help Topic DMD0208 

System Nickname Locations 

for details 

 

Ladder View – added Ctrl+/ (control-slash) hot key to toggle documentation on/off quickly.  Great 

when online and needing more logic status real estate, Ctrl+/ turns off documentation temporarily to 

give you more contacts/coils/boxes on your screen.  Hit Ctrl+/ to bring it back to “normal”, Ctrl+/ to turn 

it back off.  Very handy when you just need to temporarily turn off documentation in your Ladder View. 

 
Browse Videos Dialog 

The new Browse Videos dialog box lets you navigate all the videos, and it supports keyword filtering 

and title text search to watch any/all videos (see Help->Browse Videos). 
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Video Download Utility 

The new Video Download utility can be especially helpful for installations where Internet access is 

erratic or does not exist.  By downloading relevant videos to your hard drive ahead of time, you can still 

play these videos regardless of your Internet connection at those critical moments!  (see 

Help->Download Videos). 
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2.0.3 Modifications 

1. Fixed major issue when writing a 1.4 (or earlier) disk project using Designer 2.0.2 or 2.0.1 down to a 205 

or Terminator CPU.  The PLC project may not be read back from the PLC correctly.  Ladder memory will 

be interpreted as one large monolithic block of code (no $Main).  Workaround with 2.0.2 or 2.0.1: make a 

change to the Memory Configuration before writing to the PLC.  Fix: 2.0.3 fixes this issue. 

 

2.0.2 Modifications 

1. Dashboard 

a. Currently installed BRX POM included in Power Budget calculation when online; offline and online 

Power Budget dialog lists power usage for the various POMs since they are hot-swappable making 

the Power Budget dynamic: 

  
b. reload button properly refreshes at the current scrolled position 

c. CPU panel shows Mode Switch position next to actual PLC mode 

d. clicking on Ethernet port lets you Edit IP Configuration 

e. adjusted behavior of Ethernet panel items on non-Ethernet PLCs 

f. smarter display of SD Card and Mode Switch when offline 

g. made aware of adding/removing data-blocks 

h. added High Speed I/O tab (HSIO) 

i. added confirmation message box when disabling Ethernet I/O Master or disabling EtherNet/IP Server 

j. added Monitor Ethernet I/O to Ethernet I/O Master panel item’s pop-up menu 

2. System Configuration dialogs 

a. BRX Discrete Input Filter – changed default filter time to 10ms; so then the BRX High Speed Input 

dialogs will notify user if a high speed input is configured to use that slow default filter time 

b. BRX Discrete Input Filter – changed “response times” to “filter values” 

c. BRX Analog Input Configuration – correctly displays analog current units 0.61 uA 

d. BRX Analog Output Configuration properly displaying electrical units 

e. BRX Analog Output Configuration shows max 16 bit signed raw value as 32767 

f. BRX Analog Input and Output Configuration – replaced “Range Limit” phrase with “Clamp” 

g. BRX Setup Interrupt Timer clamps on max value entry and also displays microsecond entry values in 

their seconds/millisecond equivalent 

h. BRX Setup Interrupt Event Configuration dialog has a “Clear” button 

i. BRX Table Driven Output dialog has correct TDODECFG mnemonic 

j. Memory Configuration dialog no longer initially has Hide Built-in Blocks checkbox CHECKED 

k. SMTP Configuration dialog and Ethernet I/O Monitor dialog misspellings fixed 

l. Reduced multiple “nag” dialogs when making System Configuration changes when online 

m. Help button now works on Setup BRX POM dialog, BRX Setup Discrete Input Filter dialog, BRX 

Setup Analog dialog, Edit User Password dialog 
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3. GSREGRD/GSREGWR correctly labeled as Fully Asynchronous (5649) 

4. RX/WX instruction From/To Local/Remote editors no longer initially clearing Local field (this may have 

been an issue in other element editor fields in 2.0.1) 

5. AXHOME editor is 2 columns 

6. Changed wording of AXCONFIG’s “motion fault limit” parameters to “overtravel fault limit” 

7. AXCAM editor reminds users to hit the “Apply to table” button when making changes to the table 

configuration parameters 

8. Made Do-more serial protocol more robust 

9. Ladder View properly displays long Unassigned Nicknames and Symbolic Constants in contacts and coils 

(5658) 

10. Element Editor Auto Complete now shows Structure level nicknames which have valid structure fields for 

that parameter  (5659) 

11. Browse PLC File System – bumped application timeout to 10 seconds (5655) 

12. Select Project dialog’s PLC Subtype Specification list shows voltage range next to power-supply type 

13. Do-more Technology version takes you to the new Download Firmware/Gate Array dialog instead of the 

System Information dialog when looking to update your PLC 

14. Project Browser shows the Sort By settings for the Control Logic and the Configuration/Memory nodes of 

the browser tree (5281) 

15. Fixed some modality issues with various dialog boxes 

16. Browse Videos dialog can sort based on Location column (Disk vs. Internet) 

17. Video Download Utility reports error messages in addition to the error codes 
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For details about updates for version 1.4 and earlier, see this online document: 

http://forum.hosteng.com/wndm/Updates_1_4.pdf 


